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Resumen

En el panorama de una constante evolucién de la investigacion cientifica, la
integracion de la biofisica al campo de la ciencia de los materiales ha surgido como
un enfoque interdisciplinario, donde se exploran conocimientos novedosos Yy
técnicas nuevas que convergen en un punto: la biologia y la fisica. Este
acercamiento ofrece conocimientos notables sobre el desarrollo de los organismos
Vivos y su aplicacién a principios fisicos para descifrar mecanismos de la vida. Por
esto mismo, el estudio de las interacciones entre organismos representa una
relacion compleja que ha atraido gran interés en el campo de la biofisica. El analisis
de hongos modelos como Trichoderma han sido objeto de un gran nimero de
estudios, ya que se utilizan como agentes de control biolégico y estimuladores del
crecimiento en plantas, como es el caso de la planta modelo Arabidopsis thaliana.

El enfoque que se dara en este proyecto es examinar la respuesta que tenga el
micelio del hongo Trichoderma atroviride cuando se encuentra en interaccion con la
raiz de plantula de Arabidopsis thaliana, registrando el crecimiento del hongo
filamentoso a nivel hifa y nivel colonia por medio de microscopia Optica de campo
claro. Para poder realizar esta observacion se construy6 un sistema de microscopia
gue nos permitid hacer capturar una imagen de parte de un micelio cada diez
minutos durante 24 h, teniendo como resultado un conjunto de imagenes de lapso
de tiempo para ser analizadas por procesamiento digital. La base de los
experimentos es estudiar diez muestras donde cinco estaran con presencia de la
plantula y las cinco restantes estaran con ausencia de ella. Estas observaciones
fueron hechas en condiciones controladas de temperatura (22° C) y humedad
(65%), bajo iluminacién de luz roja (A = 600-650 nm) para mantener un crecimiento
vegetativo en el hongo.

Con el fin de analizar el crecimiento del hongo, se usaron dos softwares
(ImageJ/F1Jl y Mathematica) que nos permitieron realizar el procesamiento y estudio
de imagenes por muestra. Se obtuvo como resultado la velocidad del crecimiento
del apice de las hifas individuales o el avance del frente de colonia. Se encontré que
la velocidad promedio de crecimiento total del hongo es de 4.10 um/min en la prueba
control (sin planta) y 2.40 um/min en la muestra experimental (hongo-plantula).
Ademas, debido a los cambios que fueron observados se realiz6 un segundo
analisis que nos permitié identificar cambios morfolégicos en el hongo en ambos
casos a nivel macroscoépico después de 24 h, 48 hy 72 h. Estos resultados indican
existe un reconocimiento a distancia entre el hongo y la raiz de la plantula, capaz
de modular la velocidad de crecimiento del hongo y cambiar la forma de la colonia.



Palabras clave: Arabidopsis thaliana, Trichoderma atroviride, plantas, hongos,
micelio, hifa, morfologia, microscopia, interaccion, velocidad de crecimiento.



Abstract

In the context of a constant evolution of scientific research, the integration of
biophysics in the field of materials science has emerged as an interdisciplinary
approach, where novel knowledge and new techniques are offered that converge at
one point; biology and physics, offering remarkable knowledge about the
development of living organisms and its application to physical principles to decipher
mechanisms of life. For this reason, the study of interactions between organisms
represents a complex relationship that has attracted great interest in the field of
biophysics. The analysis of model fungi such as Trichoderma have been the subject
of a large number of studies, since they are used as biological control agents and
growth stimulators in plants, as is the case of the model plant Arabidopsis thaliana.

The focus that will be given in this project is to examine the response of the mycelium
of the fungus Trichoderma atroviride when it is in interaction with the seedling root
of Arabidopsis thaliana, recording the growth of the filamentous fungus at the hyphal
level and colony level by means of bright field microscopy. In order to make this
observation, a microscopy system was built that allowed us to capture an image of
part of a mycelium every ten minutes for 24 hours, resulting in a set of time-lapse
images to be analyzed by digital processing. The basis of the experiments is to study
ten samples where five will be with the presence of the seedling and the remaining
five will be without it. These observations were made under controlled conditions of
temperature (22° C) and humidity (65%), under red light illumination (A = 600-650
nm) to maintain vegetative growth in the fungus.

In order to analyze the growth of the fungus, two softwares were used (ImageJ/FIJI
and Mathematica) that allowed us to process and study images per sample. The
speed of growth of the apex of individual hyphae or the advancement of the colony
front was obtained as a result. It was found that the average total growth speed of
the fungus is 4.10 um/min in the control test (without plant) and 2.40 um/min in the
experimental sample (fungus-seedling). Furthermore, due to the changes that were
observed, a second analysis was carried out that allowed us to identify
morphological changes in the fungus in both cases at a macroscopic level after 24
h, 48 h and 72 h. These results indicate there is a remote recognition between the
fungus and the root of the seedling, capable of modulating the growth speed of the
fungus and changing the shape of the colony.

Keywords: Arabidopsis thaliana, Trichoderma atroviride, plants, fungi, mycelium,
hypha, morphology, microscopy, interaction, growth rate



1. INTRODUCCION

El estudio de la ciencia de los materiales es multidisciplinario y esta centrado en la
investigacion de las propiedades, estructura, procesamiento y aplicaciones de los
materiales (Callister, 1985). El area de los biomateriales y la biofisica, al ser campos
interdisciplinarios, tienen un papel crucial en el desarrollo de materiales en contextos
biolégicos y médicos. Por lo anterior, se ha planeado el estudio de diversos
organismos modelo (plantas, animales y hongos), en los cuales se pueden aplicar
los principios y métodos de la fisica, quimica y matemética, con el fin de comprender
principios de organizacion y funcionamiento de los sistemas bioldgicos.

Una de las investigaciones que ha aportado mas informacion en este campo se
debe a los hongos filamentosos, debido a que estos microorganismos pueden ser
usados para producir biomateriales y polimeros sostenibles y biodegradables a
base de micelio (Jones, 2018) (Goh, 2014).

Los hongos del género Trichoderma spp. ha sido utilizado en el area de los
materiales, ya que son conocidos por su capacidad para producir enzimas y
metabolitos valiosos para la produccion de materiales de origen bioldgico, y en la
produccién de polimeros biodegradables (Silva, 2017). Del mismo modo, se ha
estudiado el impacto que existe en la interaccién entre los hongos y plantas
(Wubben, 2018), en las cuales los hongos confieren beneficios a las mismas al
promover el crecimiento, la induccion de la resistencia a enfermedades, una mejora
en la tasa de germinacion y tolerancia al estrés bidtico y abiético. Se han propuesto
varios mecanismos por los cuales Trichoderma mejora el crecimiento y desarrollo
de la planta; aun asi, el entendimiento del proceso por el cual se establece esa
relacion hongo-planta adn no esta claro. Se ha llegado a la conclusiéon de que el
hongo tiene la habilidad de incrementar la asimilacién de nutrientes y su solubilidad
en el suelo, y la modificacion en la morfologia de la raiz; lo cual contribuye a la
busqueda de agua y nutrientes, sintesis de fitohormonas y la produccion de
compuestos volatiles (Salazar-Badillo et al., 2015).

Existen interacciones entre hongos filamentosos y plantas, las cuales producen
asociaciones simbioticas que pueden ocasionar efectos positivos al estimular en el
crecimiento de ambos organismos o, por otro lado, interacciones negativas que
incluyan competencia o parasitismo que den como resultado un dafo en el
crecimiento de uno o ambos organismos (Rebolledo-Prudencio et al., 2020).

En este proyecto, se usara al hongo filamentoso Trichoderma atroviride y la planta
modelo Arabidopsis thaliana, teniendo como antecedente que se ha demostrado
gue, este hongo aumenta la produccion de raices laterales, incrementa la longitud
de las raices, hace resistente a la planta ante enfermedades y estimula el
crecimiento de los pelos radiculares (Nieto-Jacobo et al., 2017). Este beneficio que
le otorga el hongo a la planta es de gran importancia porque le proporciona a la raiz



un anclaje que contribuye a la facil adquisicion de agua y nutrientes provenientes
del suelo (Contreras-Cornejo et al., 2009).

En esta investigacion, nos enfocaremos en esta respuesta de reconocimiento del
micelio en presencia de la raiz de la planta empleando videomicroscopia, con el fin
de determinar de manera cualitativa y cuantitativa los cambios morfologicos del
hongo durante esta interaccion. La manera en que mediremos esta respuesta sera
obteniendo el promedio de la velocidad de crecimiento en el micelio en dos
situaciones, al estar creciendo solo y en presencia de la raiz de la plantula. De igual
forma, mediremos de manera macroscopica los cambios que presente el micelio a
nivel colonia al paso de 24, 48 y 72 horas.

1.1 Laimportancia de las interacciones biologicas en los

ecosistemas

Las interacciones bioldgicas son procesos indispensables para los ecosistemas, ya
gue influyen en la supervivencia y la evolucion de las especies. Estas interacciones
abarcan una amplia gama de relaciones entre las especies de los ecosistemas
complejos, dando forma a la estructura, la dinamica y el funcionamiento de los
mismos. En cada uno de los procesos de las interacciones hay consecuencias
Gnicas que pueden variar, desde relaciones cooperativas hasta luchas competitivas,
y desempefian un papel crucial en la determinaciéon de la distribucion, abundancia
y diversidad de especies dentro de un habitat determinado (Connell, 1983).

Las interacciones biolégicas son dinamicas y pueden cambiar debido a factores
como cambios ambientales, cambios climaticos o introduccién de nuevas especies.
Comprender las implicaciones evolutivas y la importancia ecolégica de las
relaciones entre especies es fundamental; por ejemplo, para entender la conexién
entre especies que impulsa sus adaptaciones a lo largo del tiempo o el equilibrio
gue mantiene la estructura y el funcionamiento de un ecosistema (Callaway, 2007).

1.1.1 Clasificacion de las interacciones bioldgicas

La interaccion entre organismos de distintas especies se conoce como simbiosis, la
cual involucra una gran variedad de fen6menos que comparten aspectos centrales
como “la vida en comun y en contacto entre organismos de diferentes especies”
(Margulis, 2002). La simbiosis incluye diferentes tipos de interacciones, por lo que
los organismos que estan en esta relacion se conocen como simbiontes y estos
pueden verse beneficiados mutuamente, no verse afectados o verse perjudicados
en esta relacion. En base al tipo de interaccion, se presenta la siguiente
clasificacion:



Mutualismo

En esta interaccion, las especies interactuantes se ven beneficiadas en igual
medida, esto implica que la asociacidn es necesaria para la supervivencia de ambas
especies (Sanchez-Guillén, 2021). Un ejemplo de este tipo de simbiosis es el
beneficio que le otorga algunos tipos de hongos a las plantas al promover el
crecimiento de las mismas, mientras que las plantas le ofrecen refugio al hongo.
Otro caso, son las abejas que se alimentan del polen de plantas, mientras que las
abejas se llevan el polen de estas esparciéndolo para polinizar otras plantas (Figura
1.0).

Comensalismo

En este caso, una de las especies involucradas se beneficia, mientras que la otra
no recibe ni dafos ni beneficios (Sanchez-Guillén, 2021). Un ejemplo de esta
simbiosis es la relaciéon que hay entre las lombrices de tierra a diversos tipos de
plantas, ya que las lombrices ayudan a crear canales de irrigacion que benefician a
las plantas. Por otro lado, esta el caso de los pajaros que establecen sus nidos en
ramas de arboles ya que estos arboles no se ven afectados por dicha alteracion,
generando un habitat para el pajaro en el arbol (Figura. 1.a).

Parasitismo

En este caso, una de las especies interactuantes se ve afectada y en ocasiones
esta relacidon puede ser letal. En este tipo de simbiosis, una especie se beneficia de
la otra, siendo denominadas parasito y hospedador, respectivamente. El parasito se
nutre del huésped, quitdndole los recursos que adquiere y debilitandolo (Sanchez-
Guillén, 2021). Un ejemplo de este tipo de simbiosis, son las termitas que infectan
a los arboles y los destruyen casi por completo. Otro ejemplo son las garrapatas
gue habitan el pelaje de animales como los perros, que generan alteraciones en su
salud (Figura 1.b).

) - D G ow

|
A

-

Figura 1. Ejemplos de los tipos de simbiosis. a) Comensalismo, los péjaros establecen sus nidos en
ramas de arboles que no se ven afectados por dicha alteracion, generando un habitat para el pajaro
en el arbol. b) Parasitismo, en este caso las garrapatas habitan el pelaje de animales como los perros,
que generan alteraciones en su salud. ¢) Mutualismo, en este caso las abejas se alimentan del polen
de plantas, por otro lado, las abejas se llevan el polen de las plantas esparciéndolo para polinizar
otras plantas.


https://comportamientode.com/etologia/parasitismo-tipos/

1.1.2 El interés en el estudio de las interacciones entre

los hongos y las plantas

Las interacciones entre hongos y plantas presentan diferentes facetas simbidticas,
como relaciones mutualistas en las cuales los hongos ayudan a la planta para
absorber nutrientes, dandoles la capacidad de potenciar su crecimiento y resiliencia.
A su vez, la planta proporciona carbohidratos a los hongos, presentando asi un
intercambio beneficioso (Zeilinger et al., 2015). Por lo tanto, se han encontrado
evidencias de eventos de una sefializacién y reconocimiento en esta interaccién
hongo-planta para ofrecer un intercambio benéfico (Camarena-Gutiérrez 2012).

Las interacciones entre plantas y hongos son un aspecto importante de la ecologia
y la biologia, ya que son caracterizadas por relaciones simbidticas que pueden
conducir a adaptaciones significativas en la morfologia de ambos organismos, estos
cambios les permiten prosperar y coexistir en diversas condiciones ambientales.
Estas interacciones son cruciales para la adquisicién de nutrientes, la adaptacion
ambiental y la dindmica general del ecosistema. La importancia del estudio de estas
relaciones proporciona informacién valiosa sobre las complejidades de la
interconexion del mundo natural.

Los hongos interactian de manera positiva 0 negativa con las raices de las plantas,
ya sea en el ambiente o en el laboratorio de forma controlada, que van desde
asociaciones mutualmente beneficiosas o letales. Es por eso por lo que, los hongos
se conocen por ser adaptables y diversos teniendo un papel fundamental en el
desarrollo vegetal. Por otro lado, las plantas proporcionan alimento y refugio a una
gran variedad de especies de hongos. Sin embargo, las interacciones entre estos
dos organismos son asociaciones complejas que ocasionan resultados diversos
(Zeilinger et al., 2015), puesto que también se tiene relaciones negativas; por
ejemplo, existen hongos patdgenos que causan enfermedad en las plantas
proporcionando una desestabilidad en el huésped.

La parte esencial de estas interacciones esta en el intercambio de nutrientes, donde
los principales érganos involucrados son las raices de las plantas y las hifas de los
hongos (Camarena-Gutiérrez 2012), en donde ocurre un cambio de recursos que
son importantes para su supervivencia. Al ser un proceso que ha ido evolucionando
con el paso del tiempo, ha dado como resultado una gran variedad de mecanismos
y estrategias por parte de ambos sistemas para lograr una relacion positiva, por
ejemplo, las plantas han desarrollado estrategias para establecer un crecimiento
estable y hacer frente a cualquier estrés bibtico o abiotico, por lo tanto, las plantas
tienen procesos de reconocimiento selectivo entre los organismos que son
beneficiosos o perjudiciales para ellas. Con esto en mente, hace méas de 30 afios
se pensoé en una nueva hipotesis, la cual postulaba que los hongos que crecian en
el suelo compartian una relacion simbidtica beneficiosa con las plantas terrestres
(Humphreys et al., 2010).



1.2 Las alteraciones morfolégicas en hongos en

respuesta a senales externas

Las rutas de sefalizacion en los hongos desempefian un papel fundamental en la
comprension de los analisis en los procesos bioldgicos. Algunos ejemplos de estos
procesos son, el crecimiento, la reproduccion, la respuesta ante cambios en el
medio ambiente. Las vias de sefalizacion fungica implican la deteccién y la
transduccion de sefales externas, las cuales son detectadas por receptores o
sensores especificos en la superficie de la célula fungica o dentro de la célula
(Santner & Estelle, 2009).

Los hongos conforman un grupo diverso de microorganismos y son componentes
integrales de los ecosistemas de todo el mundo. Los hongos muestran cambios
morfologicos en respuesta a una variedad de sefiales externas en su entorno, estos
cambios son fundamentales para su supervivencia, crecimiento e interacciones
ecoldgicas. El estudio de cambios morfolégicos en hongos es importante para
diversas aplicaciones en la biotecnologia, las ciencias ambientales, la agricultura y
la medicina.

Uno de los aspectos importantes cuando se estudian cambios morfolégicos
presentes en el hongo es analizar su tasa de crecimiento (Antal et al., 2000). El
estudio del crecimiento del hongo se centra tipicamente por las extensiones de las
hifas, las ramificaciones y la produccién de estructuras reproductivas como las
esporas. Cabe sefalar que los hongos muestran diferentes tasas de crecimiento
segun la especie y las condiciones especificas en las que se cultivan. Los hongos
pueden tener una tasa de crecimiento rapida y pueden producir colonias visibles en
un periodo corto de tiempo, mientras que otros hongos pueden mostrar tasas de
crecimiento mas lentas y tomar un tiempo mas largo para formar colonias visibles.
Por ejemplo, los hongos de crecimiento rapido como los son ciertas especies de los
géneros Aspergillus o Penicillium pueden colonizar sustratos y formar redes de
micelio visibles en cuestion de dias, mientras que otros hongos pueden tardar
semanas o incluso meses en mostrar un crecimiento visible.

En cuanto a los hongos del género Trichoderma spp. en los cuales se han hecho
analisis para comparar el desarrollo bajo diferentes tipos de estrés son; Trichoderma
harzianum, Trichoderma virens, Trichoderma atroviride, Trichoderma hamatum,
Trichoderma longibrachiatum, Trichoderma aureoviride. Los analisis realizados en
estas cepas son: estudios a nivel macroscopico midiendo el radio de la colonia
después de 4, 11 y 17 dias (Antal et al., 2000) La importancia de este tipo de
estudios es comprobar informaciéon util sobre como aplicar distintas cepas de
biocontrol en suelos agricolas con relacién especifica de agua, pH y niveles de
nutrientes (Begoude, 2007).



Otro tipo de hongos que presentan cambios en su forma son los denominados
patdogenos, estos hongos son una representacion de como los cambios
morfolégicos juegan un papel importante en las interacciones con las plantas
huéspedes. Estos cambios en su forma les permiten iniciar infecciones, superar las
defensas de las plantas y establecerse dentro de los tejidos del huésped. Como
muestra de algunos cambios morfolégicos en los hongos patégenos se tiene
Ustilago maydis (Figura 2.a), el cual es un patdégeno que infecta a las plantas de
maiz. Este hongo presenta un ciclo de vida dimorfico, empezando por ser células
similares a levaduras hasta formarse en hifas filamentosas. Las células parecidas a
levaduras son responsables de la invasion inicial de los tejidos vegetales, mientras
que las hifas se forman hasta estar dentro del huésped provocando la formacién de
tumores conocidos como carbén de maiz (Huitlacoche) (Boélker, 2001). Del mismo
modo, el hongo Magnaporthe oryzae, es un patdgeno devastador, sufre una
transicion morfolégica de una forma hifal vegetativa a una estructura de infeccion
especializada llamada apresorio (extremo de la hifa que se encuentra hinchado). El
apresorio genera una inmensa presion de turgencia, lo que permite que el hongo
penetre en la cuticula de la planta e inicie la infeccion (Talbot, 2003). De igual forma,
el hongo Fusarium oxysporum, (Figura 2.b) es un patégeno gue vive en el suelo e
infecta una amplia gama de especies de plantas y causa su marchitez. Este hongo
muestra distintas morfologias que incluyen hifas vegetativas, clamidosporas y
estructuras especializadas llamadas microconidias y macroconidias. Estos cambios
se dan segun su etapa de vida y las interacciones con el huésped (Michielse & Rep,
2009). Finalmente, los hongos Erysiphe spp, son patdgenos biotréficos ( solo se
alimentan de células vivas) que infectan una amplia gama de plantas hospedantes,
gue revelan cambios morfolégicos Unicos durante las interacciones con el huésped,
formando estructuras especializadas llamadas haustorios (extremo de la hifas de un
hongo parasito que penetran el tejido del huésped pero permanece afuera de la
membrana) que penetran en las células del huésped para adquirir nutrientes
(Takamatsu, 2013).



Figura 2. a) Tumores en una mazorca de maiz inducido por Ustilago maydis (Bélker, 2001). b)
Imagenes de microscopia confocal de clamidosporas de proteina verde fluorescente (GFP) como
marcador en Fusarium oxysporum f. sp. lycopersici en raices de tomate. Izquierda: exterior de una
raiz de tomate (7 dias después de la inoculacién). Derecha: 22 dias post-inoculacion. Nétense las
paredes celulares rojas autofluorescentes de las clamidosporas (Michielse & Rep, 2009). Barras
de escala, 20 ym

En lo que respecta a otros estudios que han aportado en investigaciones sobre las
alteraciones morfoldégicas en hongos en presencia de plantas, estd el hongo
Trichoderma harzianum en interaccion con las raices de pepino durante las primeras
etapas de colonizacion con microscopia electrénica de barrido (SEM) (Figura 3.a),
donde se muestra los cambios de la hifa a estructuras parecidas a apresorios para
adherirse a la raiz (Yedidia I. etal., 2000). Por otro lado, se ha estudiado la
capacidad del hongo T. harzianum para colonizar las raices y estimular el
crecimiento en plantas de tabaco (Nicotina benthamiana) y plantas de tomate en la
cual, se observé por microscopia de campo claro y microscopia de barrido laser
confocal (CLSM) (Figura 3.b y 3.c), en donde el extremo de la hifa cambi6 su forma
al ser mas hinchada que lo usual (Chacén et al., 2007). Por ultimo, se observa la
actividad micoparasita de cinco cepas de hongos antagonistas los cuales son;
Gliocladium roseum (GR11), Penicillium frequentans (PF), Trichoderma atroviride
(TA312), T. longibrachiatum (TL9) y T. harzianum (TH144), que fueron colocados
contra tres patdgenos Fusarium culmorum, F. graminearum y F. nivale. Se
estudiaron mediante SEM donde las observaciones dieron como resultado la
interaccidn entre el antagonista y el patégeno el cual, establecié un contacto intimo
entre hifas dando diferentes estructuras para la colonizacién entre organismos,
donde las hifas cambian su forma a estructuras parecidas a pinzas o ganchos para
adherirse a las raices (Figura 3.d) (Pisi et al., 2006).
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Figura 3. a) Fotografias de microscopia electrénicas de barrido de raices de pepino cultivadas en
hidroponia 72 h después de la inoculacion con T. harzianum. Colonizacién extensa de la superficie
de la raiz (200x) (Yedidia I. et al., 2000). b) Analisis CLSM de la colonizacién de raices de tomate
con T. harzianum GFP22. Colonizacién extensa de la superficie de la raiz del tomate después de 24
h (Chacoén et al., 2007). c) Fotografias de microscopia 6ptica de secciones transversales ultrafinas
de raiz de tomate 18 h. Las hifas (flechas) se muestran mediante tincion con azul de (Chacon et al.,
2007). d) Accidn parasitaria de Trichoderma atroviride (TA312) contra Fusarium culmorum (FC) y F.
nivale (FN). Gancho TA312 (flecha), punta de hifa (cabeza de flecha) y crecimiento paralelo formado
contra FN (Pisi et al., 2006).

1.3 El hongo Trichoderma atroviride como modelo de

estudio

El hongo Trichoderma atroviride crece mediante filamentos conocidos como hifas.
Ademas, cuenta con un proceso llamado anastomosis en el cual, las hifas delgadas
se fusionan con otras hifas para formar una red llamada micelio (Flores-Enriquez,
2022). Esta estructura facilita el intercambio de liquidos, nutrientes e informacién
entre diferentes partes del sistema del hongo, no tiene limite de crecimiento siempre
y cuando tenga los nutrientes suficientes. Este hongo presenta un crecimiento radial
que se le conoce como colonia (Figura 4).
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La reproductividad de este tipo de hongo es caracteristica dado que se reproduce
mediante estructuras asexuales especializadas conocidas como conidios. Este tipo
de estructuras reproductivas generan una tipica esporulacion verde. Este fendbmeno
de reproduccion es desencadenado por la exposicion del hongo a la luz,
especificamente a pulsaciones de luz azul (400-480 nm), por lo que se utiliza como
modelo fotomorfogénico. Este hongo filamentoso tiene la capacidad de obtener
informacion del entorno. Debido a esto, se han desarrollado varias investigaciones
donde describen y analizan las alteraciones morfologicas presentadas por este
hongo bajo condiciones de luz y oscuridad (Casas-Flores et al., 2004).

Figura 4. Caja de Petri con colonia de Trichoderma atroviride (IMI206040) después de 7 dias de
incubacion a 28°. Ampliacion del frente de colonia donde se observa las hifas del hongo (4x). Barra
de escala: 2 cm.

La formacién de halos de conidios verdes oscuros en el hongo al ser expuesto a la
luz no es dafiina para él, mas bien le provee de una advertencia. Para el caso de la
longitud de onda correspondiente al rojo y rojo lejano (A=600-650 nm) ha habido
investigaciones donde se han percatado que esta luz no presenta un efecto que sea
notorio en el desarrollo del hongo, puesto que no hay cambios en su morfologia
(Casas-Flores et al., 2004). En la naturaleza T. atroviride se encuentra comunmente
creciendo en el suelo como saprobio o colonizando raices de las plantas, por lo que
de forma natural no siempre esta en contacto directo con la luz natural.

T. atroviride es bien conocido por sus interacciones con las plantas, que pueden
provocar diversos cambios morfolégicos tanto en el hongo como en la planta. T.
atroviride se utiliza a menudo en la agricultura como agente de biocontrol
(microrganismo usado para controlar enfermedades de plantas en la agricultura)
para promover el crecimiento de las plantas y protegerlas de patdgenos (Lorito,
2010). T. atroviride puede sintetizar compuestos que promueven el crecimiento de
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las plantas, como auxinas y citoquininas, que estimulan el desarrollo de las raices,
aumentan la absorcion de nutrientes y mejoran el crecimiento general de las plantas
(Nieto-Jacobo et al., 2017).

Hifa: es una estructura tubular en forma de hilo que constituye el componente
bésico del cuerpo del hongo, conocido como micelio. Las hifas son las unidades
estructurales y funcionales de los hongos, responsables de diversas funciones
esenciales como la absorcion de nutrientes, el crecimiento y la reproduccion. Las
hifas crecen por elongaciéon en sus puntas y pueden ramificarse y fusionarse para
formar una extensa red llamada micelio. Estas estructuras desempefian un papel
crucial en el ciclo de vida de los hongos (Alexopoulos, 1996).

Apice: en el contexto de los hongos, el término "apice" normalmente se refiere a la
punta o el extremo de una estructura fangica, como una hifa o un conidi6foro. El
apice es a menudo una region donde ocurren importantes procesos de crecimiento,
desarrollo o reproduccion (Alexopoulos, 1996).

Micelio: el micelio es la parte vegetativa de un hongo y consta de una red de
estructuras en forma de hilos llamadas hifas. Sirve como modo principal de
absorcion de nutrientes y juega un papel crucial en el ciclo de vida de los hongos.
El micelio crece y se propaga a través de su entorno, a menudo en el suelo o en
materia organica en descomposicion, formando una red compleja e interconectada
(Alexopoulos, 1996).

1.4 Arabidopsis thaliana como planta modelo

La planta Arabidopsis thaliana cominmente conocida como Arabidopsis, es un
organismo modelo en biologia y genética vegetal, ampliamente utilizado en la
investigacion debido a su genoma relativamente pequefio, ciclo de vida corto (Figura
5) y facilidad de cultivo. La planta Arabidopsis sirve como una herramienta
importante para estudiar diversos aspectos de la biologia vegetal, incluida la
genética, el desarrollo, la fisiologia y las respuestas a estimulos ambientales
(Bowman et al., 1989).

El estudio de Arabidopsis como modelo de plantas data del siglo pasado. En el afio
de 1943 se obtuvieron las primeras investigaciones acerca de las fortalezas de
utilizar esta planta en experimentos genéticos. En la década de los 60°s se
examinaron grandes cantidades de poblaciones de Arabidopsis en busca de
mutaciones en los genes (Szymanski, 2001). Pero no fue sino hasta 1998 que se
declaré como una planta modelo para el estudio de la biologia vegetal (Saraswathy
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& Ramalingam, 2011). En lo que respecta al desarrollo y crecimiento de este
organismo, se han hecho grandes cantidades de investigaciones para la ciencia
moderna. Arabidopsis es una planta muy util y facil de tratar para establecer
patrones de desarrollo respecto a su fisiologia bajo condiciones de estrés
(Woodward & Bartel, 2018).

Esta planta modelo es pequefia, crece rapidamente y florece en interiores. La
supervivencia de esta planta se ve influencia por varios factores ambientales como;
la humedad, la temperatura, el suelo, el fotoperiodo, la longitud de onda, la
presencia de microrganismos y las intensidades de la luz. La estructura de
Arabidopsis esta conformada por el tallo, los meristemos apicales, las hojas simples,
los tricomas, las estomas que se abren o cierran para regular el intercambio de
gases entre la hoja y la atmésfera, las raices, los pelos radiculares, el vascular y el
polen (Woodward & Bartel, 2018).

A. thaliana ha contribuido enormemente a la compresion de conceptos clave desde
el enfoque de la biologia gracias a su disponibilidad, recursos ambientales,
herramientas implementadas y experiencias compartidas. En donde, el estudio de
la planta demuestra caracteristicas importantes que ayudan a la compresion acerca
de rasgos vegetales. Por lo tanto, la planta se ha vuelto un “modelo genético central
y un organismo universal en la ciencia de plantas y cultivos”(Kramer, 2015).

Life history
of an Arabidopsis
individual

Figura 5. Ciclo de vida de la planta modelo Arabidopsis thaliana. En el dia cero se fotografio la
semilla antes de ser esterilizada y colocada ene le medio de cultivo, se dejo en incubacién. Al paso
de 3 dias se observo la radicula (raiz embrionaria). El crecimiento de las hojas, el tallo y la raiz
alargada fueron evidentes a los 7 dias. Después de 13 dias, la plantula se transfirié al suelo y se
cultivé a temperatura ambiente bajo luz fluorescente continua, luego se fotografié poco después de
la floracion (28 dias) y después se fotografié las vainas secas que contenian semillas maduras (50
dias)” (Woodward & Bartel, 2018).
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Plantula: una plantula es una planta joven que surge de una semilla y comienza a crecer.

Se encuentra en las primeras etapas de desarrollo, caracterizandose por la presencia de
hojas embrionarias (cotiledones) u hojas verdaderas, segun la especie vegetal. Las
plantulas suelen ser fragiles y requieren condiciones ambientales especificas, como
humedad, luz, nutrientes y temperatura adecuadas, para prosperar (The American Heritage
Science Dictionary, 2022).

1.5 Los cambios morfoldgicos que se observan en
interacciones entre Trichoderma spp. y Arabidopsis
thaliana

La interaccion entre Trichoderma spp. y A. thaliana ha sido estudiada ampliamente
como sistema modelo para comprender los efectos beneficiosos de Trichoderma
sobre el crecimiento de las plantas y los mecanismos de defensa. Las interacciones
Trichoderma-Arabidopsis han arrojado a la luz resultados sobre los cambios
moleculares Yy fisioldgicos que ocurren en las plantas durante la colonizacion por
especies del género Trichoderma, tomando en cuenta el ajuste de varios
parametros como; la luz, el medio de crecimiento, la temperatura entre otros. Se
han utilizado diferentes cepas de Trichoderma como Trichoderma virens,
Trichoderma harzianum y Trichoderma atroviride, se ha demostrado que estas
cepas otorgan un beneficio a Arabidopsis. De igual forma, en cuanto a Arabidopsis
han sido utilizadas varias mutantes o fenotipos, tal es el caso de Col-0, DR5: uidA 'y
AtERD14 por mencionar algunas (Contreras-Cornejo et al., 2009),

En cuanto a las investigaciones realizadas sobre los cambios que son presentes en
la planta al estar con el hongo, se han calculado; el peso fresco y seco, la longitud
de la raiz principal, la densidad de raices laterales, la acumulacion de auxinas, el
analisis de compuestos organicos volatiles (Lee et al. 2015), el rescate de fenotipos
defectuosos (Gonzélez-Pérez et al. 2018), el porcentaje de germinacion, el area
foliar (O. Kleifeld et al. 1992), la produccion de biomasa, la determinacion de
compuestos indolicos (Contreras-Cornejo et al., 2009) y la evaluacion del perfil de
poliaminas (Salazar-Badillo et al. 2015).

Estos tipos de investigaciones independientemente del medio de cultivo o las
condiciones de crecimiento han arrojado que Trichoderma spp. presenta un efecto
benéfico para Arabidopsis. Debido a que las plantulas tratadas con Trichoderma
promueven una mayor produccion de biomasa y un desarrollo de raices laterales
(Gonzélez-Pérez et al. 2018), ademas que mejora su salud, la hace resistente
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contra enfermedades (Inbar et al., 1996), contribuyen a la nutricién de las plantas e
inducen respuestas de defensa (Ojaghian et al. 2019).

Una situaciéon muy importante para considerar son las técnicas de investigacion por
las cuales podemos analizar las interacciones entre hongo y la planta, por lo tanto,
uno de los procedimientos mas usados son las técnicas de microscopia avanzada,
la cual sirve para caracterizar este tipo de interacciones, que ha llevado a el
desarrollo de investigaciones en este campo (Zeilinger etal., 2015). Entre los
métodos de microscopia mas usados encontramos microscopia de campo claro
(BF), microscopia de barrido laser (CLSM) y microscopia electrénica de barrido
(SEM).

1.6 El microscopio optico de campo claro

El microscopio Optico compuesto es un instrumento utilizado para observar
ampliamente finos detalles de una muestra (Figura 6) (Sandle, 2016). La
microscopia de campo claro se basa en el principio de que la luz se transmite a
través de la muestra y el microscopio forma una imagen por diferencias en la
absorcion y refraccion de la luz entre las estructuras de la muestra (Murphy, 2001).
Cuando la muestra absorbe luz visualizaremos en la imagen una muestra oscura
contra un fondo brillante (Holgate, 2003). La iluminacién es de vital importancia, el
correcto acomodo de esta dara como resultado la formacion de una imagen con
buen contraste y resolucién, por el contrario, el tener un mal arreglo en la iluminacion
provocara sefiales de ruido y una imagen de mala calidad. EI microscopio cuenta
con dos lentes de suma importancia para la formacion de imagenes; el lente objetivo
gue capta la luz difractada por la muestra y forma una imagen real ampliada (para
objetivos de 160 mm); y el lente condensador que se encarga de concentrar la luz
en un area pequefa de la muestra (Murphy, 2001). De igual forma, se hacen uso de
objetivos adicionales (2x, 4x, 10x, 15x o 20x) que se utilizan en la lente ocular para
proporcionar un factor adicional (Guzman Altamirano, 2015).
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Figura 6. Microscopio éptico compuesto, las flechas sefialan el nombre de las partes principales que
lo forman.

1.6.1 Las aplicaciones del microscopio optico: La

videomicroscopia

La videomicroscopia se refiere al uso de técnicas de microscopia combinadas con
grabacion de video para capturar y analizar procesos dinamicos en muestras
biolégicas o materiales. Implica el uso de microscopios especializados, equipados
con camaras o sistemas de imagenes digitales para visualizar y registrar el
comportamiento en tiempo real de estructuras microscopicas como células u
organismos (Wilson T. &., 2019). La captura de una serie de imagenes a alta
velocidad proporciona un registro continuo del comportamiento de la muestra, lo
gue ofrece informacién valiosa sobre su dinamica y cambios temporales (Gibson,
2019). La microscopia de video permite a las y los investigadores observar y
estudiar los procesos bioldgicos que se desarrollan en el tiempo, como: la divisién
celular, los movimientos celulares, las interacciones moleculares y el desarrollo de
tejidos.

Ademas de la observacion visual, la videomicroscopia a menudo involucra varias
técnicas de procesamiento digital y analisis de imagenes para extraer informacion
cuantitativa de los videos grabados (Figura 7). Estas técnicas pueden incluir: el
seguimiento del movimiento de objetos, la medicibn de parametros celulares y
subcelulares, el analisis de la intensidad o distribucion de ondas fluorescentes y la
realizacion de analisis estadisticos en grandes conjuntos de datos (Wilson, 2019).
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La videomicroscopia tiene numerosas aplicaciones en la investigacion biolégica, la
medicina, la ciencia de los materiales y otros campos. Ha contribuido a los avances
en biologia celular, microbiologia, neurociencia, biologia del desarrollo,
farmacologia y mas (Prevedel R. Y., 2018). La capacidad de estudiar y comprender
los procesos dinamicos a nivel microscopico a través de la videomicroscopia ha
ampliado en gran medida nuestro conocimiento de los sistemas biologicos y ha
llevado a descubrimientos e ideas que quizas no hubieran sido posibles solo con
imagenes estaticas (Liao, 2020).

@
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Figura 7. Sistema de videomicroscopia. Para conformar el sistema de observacion, utilizamos el
microscopio optico de campo claro que sera conectado a una computadora que nos permitira
observar y capturar imagenes de la muestra.

1.7 El procesamiento digital de imagenes: Técnicas

utilizadas

El procesamiento de imagenes se refiere a la manipulacion y el analisis de imagenes
digitales utilizando varios algoritmos y técnicas. Implica aplicar operaciones y
transformaciones matematicas a los arreglos de numeros que conforman las
imagenes digitales para mejorar la calidad de la imagen, extraer informacioén util o
modificar su apariencia. El procesamiento de imagenes se puede realizar en
fotografias, gréaficos o cualquier otra forma de imagenes digitales (Rafael Gonzalez,
2017).

El objetivo principal del procesamiento de imagenes es mejorar la percepcién visual
de las imagenes o extraer informacion valiosa de ellas. El procesamiento de
imagenes se puede utilizar para una amplia gama de aplicaciones, que incluyen:

Mejora de la imagen: ajuste de las propiedades de una imagen para mejorar su
calidad visual, como el ajuste del brillo, el contraste o la nitidez.
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Restauracion de imagenes: reparacion o reconstruccion de imagenes degradadas
0 dafladas causadas por ruido, desenfoque u otros artefactos.

Compresion de imégenes: reducir el tamafio de un archivo de imagen mientras se
preserva su calidad visual eliminando informacion redundante o irrelevante.

Segmentacion de imagenes: dividir una imagen en regiones significativas u
objetos en funcién de ciertas caracteristicas, como el color, la textura o la forma.

Extraccion de caracteristicas: identificar y extraer caracteristicas o patrones
especificos de las imagenes, como bordes, esquinas o texturas.

Reconocimiento y deteccion de objetos: identificar y localizar objetos o patrones
especificos dentro de una imagen o una secuencia de imagenes.

Clasificacion y categorizacion de imagenes: asignacion de imagenes a
categorias o clases predefinidas en funcién de su contenido visual o caracteristicas.

El campo abarca una amplia gama de técnicas y algoritmos, incluidos el filtrado, la
deteccién de bordes, las operaciones morfolégicas, el analisis de Fourier y los
enfoques basados en el aprendizaje automatico, entre otros. Las técnicas de
procesamiento de imagenes se pueden utilizar en varias aplicaciones, incluidas
imagenes meédicas, vigilancia, vision por computadora, sensores remotos y
sistemas multimedia (Rafael Gonzalez, 2017).
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1.8 Hipotesis

La interaccion del hongo Trichoderma atroviride con la plantula Arabidopsis thaliana
induce cambios en la velocidad de crecimiento y alteraciones morfologicas del
micelio.

1.9 Planteamiento del problema

Estudiar el sistema de micelio del hongo T. atroviride con la raiz de A. thaliana bajo
microscopia de campo claro, con un enfoque en los cambios que presente el micelio
en su velocidad de crecimiento al paso del tiempo. Se incluirdn muestras con
ausencia (control) y presencia de Arabidopsis.

Para obtener los datos necesarios se empleard un procesamiento de imagenes
mediante el software ImageJ/FIJI, el cual nos arrojard elementos como las
coordenadas de las puntas de las hifas o el centro del frente de colonia fungica, que
seran analizados usando el programa Mathematica, para obtener el promedio de la
velocidad de crecimiento del micelio bajo diferentes condiciones. De igual forma,
haremos un estudio a nivel macroscépico para observar y analizar cambios
morfoldgicos en la colonia del hongo.

1.10 Objetivos

1.10.1 Objetivo general

Determinar la respuesta en el micelio del hongo Trichoderma atroviride en presencia
de la planta Arabidospsis thaliana.

1.10.2 Objetivos especificos

o Estructurar un modelo experimental que permita observar el micelio del
hongo de T. atroviridie en interaccion con la raiz de A. thaliana.

o Observar mediante microscopia Optica de campo claro la interaccion del
micelio de T. atroviride con la raiz de A. thaliana con un “stack” (agrupacion
de multiples imagenes) de imagenes en 24 h.

o Analizar los cambios en la morfologia en la estructura del micelio mediante
procesamiento digital de imagenes.
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Determinar el promedio de la velocidad de crecimiento del micelio en

interaccion con Arabidopsis.
Estudiar las alteraciones en la forma de la colonia del hongo con presenciay
ausencia de la plantula.
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2. METODOLOGIA DE INVESTIGACION
2.1 La preparacion de organismo

Para realizar el cultivo del hongo y la planta de manera correcta, y seguir las
condiciones 6ptimas del crecimiento de ambos organismos, se establecio una linea
del tiempo para acoplar las fases de crecimiento de los organismos (Figura 8).
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Figura 8. Linea de tiempo para el cocultivo de la plantula y el hongo, la cual muestra las diferentes
etapas requeridas para cada organismo para su crecimiento de manera dependiente del tiempo para
acoplar a ambos sistemas bioldgicos.

2.1.1 El hongo Trichoderma atroviride

Para cultivar el hongo, es necesarios hacer la preparacion y el conteo de conidios
para lograr una suspension 1x10°conidios/mL. En un ambiente estéril se inocularon
10 pL de la cepa de T. atroviride IMI204060 sobre una placa Petri con medio PDA
(Potato Dextrose Agar) y se incuba a 27 °C por 7 dias (Figura 9.a). Posteriormente,
se realizo la recoleccidon de conidios usando agua destilada estéril. Para cuantificar
los conidios, se realizé una dilucién 1:100 y se depositaron 10 pL de conidias en
una camara de Neubauer y se implementd el protocolo descrito en el Apéndice 1,
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para obtener la cantidad de conidios que requerimos (Figura 9.b). Cabe sefialar que
este procedimiento se realizé cada mes para tener conidios nuevos en cada muestra
y no pierdan viabilidad.
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Figura 9. a) Proceso para obtener los conidios frescos. Con ayuda de una micropipeta se inocula 10
ml de una suspension de conidios en glicerol en el centro de una placa Petri, se deja en incubacién
por 7 dias para obtener crecimiento vegetativo en la placa. Al cabo de los 7 dias se recolectaran los
conidios raspando la superficie de la placa. b) Proceso de conteo de conidio frescos. Una vez
recolectados los conidios de la placa se realizard una dilucién 1:100 que sera depositada en la
cédmara de Neubauer para contar los conidios en el microscopio 6ptico y realizar una nueva dilucién
para obtener 1x10° conidios/mL.

Para nuestra investigacion se utilizo el medio MS (Murashige & Skoog), debido a
que permite el crecimiento de la planta y el hongo. Para la preparacion del medio,
se utilizo medio MS, sacarosa y agar, la cantidad requerida dependié de la
proporcion de medio MS a preparar. El medio MS se esterilizé en la autoclave por
2 h, donde una vez estéril se vertera en placas de Petri antes que se solidifique y
seran llevadas al cuarto de 4 °C hasta el momento que se requieran usarlas.
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2.1.2 La planta Arabidopsis thaliana

Las semillas de Arabidopsis Ecotipo Col-0 se lavaron en un ambiente estéril con
etanol al 70% durante 3 minutos, después seran lavadas por cloro al 20% durante
7 minutos y finalmente se enjuagaron cuatro veces con agua destilada estéril (Figura
10.a).

Una vez estériles, se procedié a sembrarlas en una placa Petri con medio MS. Se
tomaron las semillas con una micropipeta y se esparciran en la superficie de la placa
(Figura 10.b), al término de la siembra se cubrio la placa con aluminio y se incubaron
a 4° C por dos dias, para la sincronizacion de las semillas. Posteriormente se llevo
la placa a la camara de crecimiento a una temperatura de 22 °C y un ciclo de 16 h
luz y 8 h oscuridad.

Al paso de 4 dias en la camara a 22 °C se realizé el primer trasplante de varias
plantulas a una nueva placa de Petri con medio MS. Después de dos dias, se realizé
un segundo trasplante a los 7 a 9 dias de edad de las plantulas, colocando una
plantula por placa para proceder a observarla junto con el hongo (Figura 10.c).
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Figura 10. a) Para realizar el proceso de lavado de semillas usamos cloro al 20%, etanol al 70% y
agua destilada estéril, estos lavados seran hechos con ayuda de un vortex. b) Una vez lavadas las
semillas utilizando una micropipeta, tomamos las semillas que viene en el tubo Eppendorf y las
depositaremos en la superficie de la placa con medio MS. c) Al cabo de 7 dias cuando tengamos las
plantulas se trasplantaran a una nueva placas Petri con medio, este trasplante lo haremos usando
pinzas estriles

2.2 El desarrollo para la elaboracion de la minicamara

Con la finalidad de establecer el acomodo apropiado de los organismos que seran
observados en nuestra investigacién, se haran pruebas para determinar donde se
tiene mejor crecimiento y visualizacién por parte del hongo y la plantula. Debido a
que es de gran importancia las observaciones de la interaccién entre planta y hongo
en el microscopio se decidié realizar la minicamara en placas Petri de 8 cm de
diametro. En esta minicAmara se vertera el medio hasta un poco mas de la mitad
de la placa para tener buena iluminacion por parte del microscopio y tener buenas
imagenes para examinar.

Se trasplanta la plantula a una edad de 7 a 9 dias para que se aclimate por 24 h a
22 °C. Al paso de un dia se inoculan 5 pl de conidios del hongo, a 5 mm de la punta
de la raiz. Posteriormente, se incuban los dos organismos en la oscuridad por 24 h
a 22 °C. Este tiempo de incubacion tiene como objetivo, que el hongo tenga tiempo
suficiente para germinar y sea posible observarlo y evitar la conidiacion por
presencia de la luz. Cumpliendo estas 24 h, se toma la minicamara y se lleva al
microscopio por 24 h mas para la observacion.
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Figura 11. Diagrama del proceso de trasplante de la plantula e inoculacion del hongo a la camara
de crecimiento. Se hace el trasplante de la plantula con una longitud de 1cm, después de 24 h en
incubacion se inoculan 5 pl de conidios a una distancia de 5 mm desde la punta de la raiz.

2.3 Las condiciones experimentales para el sistema de
observacién

Como tenemos dos organismos que crecen en condiciones controladas, pero en
situaciones diferentes, se necesitan contemplar varias propiedades que son; luz,
humedad y temperatura. Teniendo en cuenta estas condiciones y conociendo que
nuestro microscopio tendra que tomar imagenes por ciertas horas seguidas del
sistema interactuando, se tendra que colocar el microscopio en un cuarto donde
podamos controlar estos parametros. Se contempla que las propiedades en las
cuales se hara nuestra investigacion tengan sean las siguientes;

- Luz roja: Filtro Lee 182 (A =600 — 650 nm).
- Humedad: 65%
-Temperatura: 22 °C

Para poder controlar estas condiciones se ide6 una forma para la colocacién del
microscopio con nuestras muestras. Primero, se situara el microscopio en un cuarto
especial de crecimiento de plantas ubicado en el Edificio Alfa, ya que en este lugar
sera posible vigilar y controlar la temperatura y la humedad.

Por otro lado, ya que necesitamos que nuestro sistema de observacion se encuentre
en condiciones una constante observacion de la muestra bajo el microscopio, se ha
decidido que la fuente de iluminacién emita luz roja (A=600-650 nm). Esta eleccion
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se debe a que Trichoderma atroviride no presenta efectos en su conidiacién al estar
expuesto a este rango de longitudes de onda, A=600-650 nm (Casas-Flores et al.,
2004). Asi, podremos imitar las condiciones del hongo al estar creciendo por debajo
del suelo. Con base a lo mencionado anteriormente, se tendra que planear un
meétodo para la elaboracion de una caja negra que contenga el microscopio e impida
el paso de luz del exterior.

2.4 La construccion de la caja negra

Para realizar las observaciones del desarrollo del micelio utilizando el microscopio
Optico, es necesario contemplar el pardmetro de luz. Por lo tanto, debido a los
antecedentes registrados de la fotoconidiacién del hongo se utilizara un filtro rojo
gue solo deje pasar la longitud de onda (A= 600-650 nm). Por tal razon se construira
una caja negra para colocar en ella todos los instrumentos que formen el sistema
de observacion. EIl sistema de observacion incluye el microscopio con la camara
acoplada y la computadora para hacer la captura de las imagenes. El filtro se
acoplara a la ldmpara del microscopio dejando pasar la luz roja que entrara en
contacto con los organismos de la muestra para brindarles la iluminacion que
requiere el sistema.

La caja negra tiene la finalidad de manipular las condiciones de luz que nosotros
necesitamos para el proyecto y cuidar que no tengamos contaminacion de otras
longitudes de onda que provengan del exterior. Esta caja sera colocada en el cuarto
para plantas donde las condiciones de temperatura y humedad estan controladas
(T = 22 °C, Humedad relativa = 65%).

Una vez hecha la caja con las dimensiones adecuadas para el microscopio,
permitiéndonos ademas tener un espacio para su manipulacion, se procedera a
conectar con la computadora haciendo uso de un software especial, para el
microscopio y la camara, procediendo a la captura de imagenes.
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Figura 12. Diagrama del acomodo del sistema de observacion en la camara oscura, Se armo una
caja negra para el microscopio donde se colocara el instrumento para controlar la luz y evitar
contaminacion del exterior por parte de otras longitudes de onda. De igual forma se construy6 una
caja para colocar una computadora que estara conectada al microscopio.

2.5 La adquisicion y el procesamiento de imagenes

Al tener todo el sistema montado, el hongo y plantula en crecimiento en la
minicamara, siendo observados en el microscopio adaptado en la caja negra, ahora
se procedera a la toma de imagenes. Se establecié que para ver el crecimiento del
micelio con la plantula mas a detalle, la captura de las imagenes serian cada 60 s
por 24 h. Para la captura de las imagenes, se utilizara la camara de microscopio
AmScope MU300 (2048x1536 pixeles).
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Figura 13. Programa para la captura de imagenes de AmScope. Este software nos ayudara a tomar
las imagenes de manera automética por 24 h.

Para la observaciéon y toma de las imagenes se utilizara el software de AmScope
instalado en la computadora (Figura 13), el cual nos brinda opciones para crear una
visualizacion mejorada de las imagenes que estamos observando en el
microscopio. Este programa nos permitird hacer una tomada de imégenes de
manera automatizada, creando una secuencia de lapso de tiempo (time-lapse) de
captura de imagenes por 60 s en 24 h de cada muestra.

Cuando se tengan todas las imagenes necesarias, ahora se hara uso del software
ImageJ para procesar las imagenes; inicialmente lo usaremos para crear un stack
de imagenes por cada una de las muestras tomadas. Para comenzar este
procedimiento, fue necesario hacer una reducciéon en la cantidad de imagenes, lo
gue se refiere a realizar un diezmado al stack original (imagen cada 10 minutos),
por lo tanto, la cantidad total de imagenes por stack fueron 140 imagenes.

Stack de imagenes: Procesamiento digital de agrupar multiples imagenes de una
sola muestra (video o pila). Las pilas de imagenes combinan grupos de imagenes
con cuadros de referencia similares, Una vez combinadas dentro de una pila, podra
procesar las distintas imagenes en una vista compuesta para eliminar contenidos
no deseados o posibles ruidos. (Adobe, s.f.)
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Para comenzar el procesamiento de los stacks diezmados, sera necesario realizar
una segunda reduccion de tamafio de los stacks, ya que estos nos ayudaran a
facilitarnos la manipulaciéon y el analisis. Después, para tener una mejor
visualizacion y deteccion del micelio, sera necesario procesar el stack para eliminar
ruidos que se hayan provocado a la hora de la toma de las imagenes. (Flores-
Enriquez, 2022)

2.5.1 Reduccidén del tamafo del stack

En la primera etapa del procesamiento de imagenes como fue mencionado se
comenzara por realizar una compresion de imagenes para disminuir el tamafio de
los stacks y hacer un procesamiento adecuado de las imadgenes. Se comenzara
realizando la calibracién espacial de las imagenes que conforman el video (Analyze-
> Set Scale). Después se convertira a escalas de grises (8 bits). Al hacer este paso,
lo que se producira es una reduccion de tamafio y eliminar algunas interferencias
cromaticas que se hayan dado al hacer la captura de imagenes (Image -> Type-> 8
bits). Lo siguiente a realizar es segmentar la imagen, para solo tener el campo de
observacion en el cual podamos extraer informacion (Edit-> Select-> Specify).
Después, se duplicara la imagen ya con las medidas adecuadas, para proceder a
realizar los demas pasos del procesamiento (Image -> Duplicate). Siguiendo con el
procesamiento, nuestro stack alun es de un tamafo considerable, por lo tanto, se
hard otro paso para hacer una reduccién del tamafio del archivo (Image ->
Transform -> Bin), lo que se le hace en este paso es promediar conjuntos de 2x2 o
4x4 pixeles en la imagen. Finalmente, ya que, por las instrucciones que sigue el
programa AmScope para capturar las imagenes son necesarios dos stack para
completar un dia de observacion, se concatenaran los stacks que son necesarios
para realizar la muestra de 24 h (Image ->Stack ->Tools ->Concatenate).
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Figura 14. a) Stack de imagenes de las imagenes tomadas ante el microscopio. b) Stack de
imagenes después de realizarles el procesamiento de reduccion de tamafio y &rea. c) Stack de
imagenes después de realizarles el procesamiento de calibracién y eliminacion del fondo. La flecha
indica que se trata de una recopilacién de imagenes. Barra de escala: 1000 pm.

2.5.2 Calibracién y eliminacion de ruido

En la siguiente etapa de procesamiento se empezara por colocar la barra de escala
en las imagenes que conforman el video (Analyze-> Tools -> Scale Bar). Después
se hara una eliminacién del ruido de la imagen causado por el fondo o ruido
procedente del medio, por lo tanto, se aplicara un filtro gaussiano (Process-> Filters
-> Gaussian Blur). Finalmente, se procedera a sustraer el fondo (Process -> Image
Calculator) (Figura 15.c).
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2.5.3 Seleccion de intervalo espacial

Para realizar el analisis a cada stack es necesario empezar con el seguimiento del
apice de una hifa elegida, por lo tanto, se elige una ROI (Region Of Interest)
haciendo un intervalo espacial donde solo este la hifa de interés o cuando llegue el
momento el frente de colonia. Como se va haciendo un seguimiento del desarrollo
de la hifa, fue necesario hacer un traslado de area cada vez que la hifa llegaba a la
orilla del campo de vison del microscopio. Este traslado de area nos generara una
seccion del stack original que lo denominaremos sub-stack, el cual emplearemos
una serie de procesos para limpiar las imagenes que lo forman (Figura 15.a).

2.5.4 Ajuste de contraste y brillo

Con este proceso se hara una homogenizacion del fondo y se generara un contraste
entre las hifas o colonia y el medio de crecimiento. Esto lo realizamos de la siguiente
manera. Image> Adjust > Brightness and contrast (Figura 15.b).

2.5.5 Threshold

Se debe realizar un ajuste en la umbralizacion del stack para proceder hacer una
binarizacion. Image > Adjust > Threshold (Figura 15.c).

2.5.6 Binarizar y eliminar particulas

Posteriormente se realizara una binarizaciéon al stack, para solo tenerlo en escala
de blanco y negro Process > Binary > Make Binary. Lo que se hara es segmentar la
imagen en blanco y negro, esto es, los pixeles de mayor intensidad son los blancos
y los negros son de intensidad baja (Figura 16.d). Al tener las imagenes binarizadas
se observara algunas manchas presentes que pueden ser debidas a particulas en
el medio de cultivo, polvo en las lentes del microscopio, o a un mal alineamiento de
la fuente de iluminacion. Para poder eliminarlas se usara las herramientas que nos
da el programa y hacerlo de manera manual; la forma en que se hara la eliminacion
de particulas es seleccionando el area que queremos eliminar y pintando con la
escala de pixeles que ya tenemos establecida en el area de interés. Elegimos el
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pincel o el lapiz > Color que determinamos > aplicacion en el area que lo requerimos
(Figura 15.e).

2.5.7 Esqueletizacion

Finalmente, para tener el stack en condiciones en las cuales podamos estudiar y
extraer informacion de las imagenes. Se haré una esqueletizacion donde los pixeles
reducen su tamario, lo cual nos permitira determinar la forma que tiene nuestra hifa
a lo largo de su crecimiento. Process > Binary > Skeletonize (Figura 15.f). Este
procedimiento solo sera posible realizarlo cuando estemos en la etapa del analisis
por hifa.

2.5.8 La herramienta Tracking Mate

Una vez procesado el stack ahora extraeremos la informacion que necesitamos, en
este caso, son las coordenadas del 4pice de la hifa o el centro del frente de colonia
cada 10 minutos. Por lo tanto, usaremos un plugin que tiene FlJI, el cual nos permite
hacer un seguimiento de este 4pice o frente de colonia, donde de manera manual
seleccionaremos la punta o frente y de forma automatica se generaran las
coordenadas que se guardaran en un archivo Excel. Plugins> Tracking> Manual
Tracking (Figura 15.9).
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Figura 15. Pasos para el procesamiento de nuestos stack. a) Intervalo espacia, del apice de una
hifa. Elegimos la hifa que seguiremos a lo largo del video. b) Sub-stack con ajuste de contraste y
brillo, acomodamos el contraste y brillo de las imagenes para mejorar la observacién. c) Sub-stack
con umbralizacion. d) Sub-stack binarizado, convertimos el stack a escala de blancos y negros. €)
Sub-stack en donde eliminamos elementos que no son parte de la hifa, removemos particulas. f)
Sub-stack esqueletizado, hacemos un proceso donde adelgazamos el tamafio de la hifa. g) Sub-
stack con Tracking Mate, elegimos este comando para obtener las coordenadas de apice o frente de
colonia: Barra de escala 1000 pm.

2.6 El analisis de datos

Teniendo nuestro stack procesado ahora podemos hacer una serie de estudios para
ver el desarrollo que tiene esta interaccion en ambos organismos. Por consiguiente,
se hara un andlisis del crecimiento que tenga el micelio al estar creciendo solo y
creciendo en direccion a la raiz de la plantula. Para establecer un promedio de la
velocidad de crecimiento, procederemos con la ayuda de un programa que
construiremos en Mathematica. Con estos dos estudios se podra establecer si
existen una respuesta que tenga el hongo en su desarrollo mediante los andlisis de
los stacks.

También se planea hacer mediciones de las distancias recorridas por el hongo en
un intervalo de tiempo y ver su cambio al crecer con la raiz y por si solo. Para
completar nuestro estudio de manera macroscopica se estableceran los cambios en
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la morfologia de la colonia para determinar como ocurre la respuesta de
reconocimiento entre los dos sistemas bioldgicos.

a) b) c) d)

7
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Figura 16. Proceso para la obtencién de datos haciendo una captura y andlisis de imagenes. a) Caja
negra para colocar el microscopio con la cAmara para capturar imagenes y solo tener luz roja en su
interior. b) MinicAmara donde se colocaran la plantula y el hongo para su crecimiento juntos. c)
Captura y procesamiento de imagenes para obtener informacién. d) Analisis estadisticos de los datos
obtenidos.
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3.RESULTADOS

3.1 El crecimiento de organismos: Trichoderma atroviride
y Arabidopsis thaliana

Con la finalidad de obtener los conidios frescos de T. atroviride que seran usados
como inéculo para observar al hongo en la interaccion con la plantula, se
recolectaron y contaron los conidios como se describié en el capitulo anterior
haciendo uso de la camara de Neubauer y el microscopio Optico. Lo que se obtuvo
fue una suspension de 1x10°conidios/mL.

Para obtener las plantulas de Arabidopsis con una edad y longitud especificas, se
esterilizaron las semillas para seguir con su siembra, después se realizd una
sincronizacion e incubacion para tener un crecimiento adecuado de las semillas a
las plantulas. Se obtuvieron las plantulas de 7 a 9 dias con una longitud de
aproximadamente un centimetro de raiz.

Por lo tanto, tomando las condiciones y los tiempos adecuados pudimos obtener los
organismos con edad y crecimiento correcto que serdn estudiados en nuestra
investigacion.
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Figura 17. a) Semillas sembradas en placas Petri. b) Plantulas en la placa, después de 4 a 5 dias
de edad. c) Trasplante de plantulas, después de 6 dias trasplantamos nuestras plantulas a nuevas
placas Petri. Barra de escala 2 cm.

3.2 La minicamara de crecimiento

Con el objetivo de realizar una minicAmara de crecimiento para colocar al hongo y
la plantula para analizar su interaccion fue necesario seguir un orden cronoldgico.
Primero se trasplanto la plantula a la placa, donde se aclimatd por un dia a 22 °C.
Posteriormente, se inocularon 5 puL de conidios frescos a una distancia de 5 mm
desde la punta de la raiz. Para detectar el crecimiento del hongo se incub6 a ambos
organismos por 24 h mas en la oscuridad a 22 °C. Al termino de estas 24 h en
incubacion se llevo la minicamara de crecimiento al microscopio.

En cuanto a las pruebas control solo se inocul6 el hongo al centro de la minicamara
de crecimiento y se crecio bajo las mismas condiciones. Al termino de estas 24 h,
se llevé la placa para observaciones al microscopio para la recoleccion de datos.
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Con la elaboracion de la minicamara de crecimiento se desarrollé una forma de
tener un buen crecimiento tanto del hongo y la plantula. De igual forma, se evito la
contaminacion y se puedo ajustar la microcamara al sistema de microscopia y
obtener buena informacién de la interaccion de ambos organismos.

Figura 18. Plantulay conidios dia uno, en la cAmara de crecimiento. En la minicAmara que formamos
colocamos la plantula y los conidios a una distancia de 5 mm: Barra de escala 2 cm.

3.3 Laconstruccion de la caja negra

Paralelamente, se hizo la construccién de la caja negra para el microscopio, con la
finalidad de evitar contaminacion por luz del exterior. La camara se hizo en base a
las medidas del microscopio para colocarlo y manipularlo. De igual forma, se fabricé
otra caja para colocar a la computadora.

Un factor importante en este sistema es la luz roja a utilizar (A= 600-650 nm), por lo
que se us6 un filtro que solo permita pasar la longitud de onda requerida.
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Figura 19. Sistema de observacidn, camara oscura para el microscopio y caja para computadora.
En la caja de arriba colocamos la computadora que hara la captura de imagenes. En la camara
oscura de abajo instalamos al microscopio con el filtro rojo.

Al haber hecho la construccion de ambas cajas, fue necesario hacer la
comprobacioén de la estabilidad del microscopio en la caja negra, esto es, que tenga
un soporte para todos los instrumentos que conlleva el sistema y no tenga una
movilidad considerable que después sea perjudicial en la captura de imagenes. Por
otro lado, también se tiene que hacer una comprobacién en cuestion al parametro
de luz, lo que quiere decir, que la caja no deje pasar otras longitudes de onda del
exterior que no sea la que queremos y que el filtro que usamos efectivamente sea
el adecuado para este estudio, donde no le dé ningun tipo de estrés al hongo. Para
poder hacer esta comprobacion, se realizé una prueba donde se hizo una muestra
de T. atroviride inoculada en una placa de Petriy se dej6 en observacion durante 3
dias en el microscopio en un contacto con el filtro rojo, sin perturbarlo en ninguna
situacion en este periodo de tiempo.
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Figura 20. a) Microscopio con el filtro de A=650 nm al interior de la camara oscura. b) Muestra de T.
atroviride en contacto con el filtro rojo, se realizé la observacion por tres dias. ¢) Colonia de T.
atroviride a los 3 dias de observacion, se distingue que no hay una conidiacion. Barra de escala 2
cm.

Como se observa, al final de este analisis, no hubo conidiacion de Trichoderma lo
gue indica que no estuvo en contacto con longitudes de onda en el azul o UV que
hayan desencadenado el fendmeno de conidiacion, lo que concuerda con estudios
previos sobre la conidiacion por parte de T. atroviride.

3.4 La adquisicion y el procesamiento de imagenes

Para poder tener informacion de la interaccion entre el hongo y la planta, se tuvo
como objetivo crear una forma para capturar imagenes y construir una manera de
procesarlas para extraer los datos del crecimiento del hongo. Para el proceso de la
captura de imagenes, se hizo uso del software AmScope, donde se programd para
obtener un time-lapse de 24 h en la cual, se tomaron las imagenes cada 60 s por
muestra. En total se hizo una captura de 10 muestras, 5 correspondientes a las
pruebas control y 5 correspondientes a las pruebas de interaccion hongo-planta. En
cada muestra se capturaron un total de 1440 imagenes referentes a 24 h de
observacion. Estas imagenes se almacenaron de manera automatica en carpetas
gue indicaban el dia de la toma de las muestras.

Con ayuda del software de AmScope y una regleta de calibracion especial para el
microscopio se pudo determinar que para el objetivo de 2x, un pixel equivale a 3.69
pum, cantidad necesaria para poder hacer una calibracion de los stack al realizar los
analisis.
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Una vez realizada la captura de imagenes, se realizé el procesamiento de estas.
Para cada muestra tomada, el stack correspondiente estuvo comprendido por un
total de 1440 imagenes, en donde percibimos con totalidad el desarrollo del micelio.
Al contar con una cantidad de imagenes considerable, se concluyé que para
disminuir esta cantidad de imagenes y tener una mejor percepcion del crecimiento
del hongo que fuera mejor vista la diferencia de imagen a imagen, se haria un
proceso de diezmar el stack. Esto consistio en tomar las imagenes que fueron
tomadas cada 10 minutos en lugar de cada minuto y realizar un nuevo stack, de tal
modo que se redujo la cantidad de imagenes por stack a 140 por muestra. Con este
proceso realizamos un rapido y eficiente procesamiento de stacks y se observo un
mejor crecimiento del micelio.

Para limpiar los stacks, se empezd por la calibracion del stack donde convertimos
de pixeles a um (un pixel equivale a 3.69 um). Se cambié a 8 bits para disminuir su
tamafio, ademas este paso elimina algunos ruidos que se presenten en las
imagenes a la hora de su captura. Lo siguiente, es especificar el area de captura
del objetivo. También, realizamos una segunda trasformacion al stack para reducir
aun mas su tamafo y finalmente aplicar un filtro gaussiano para mejorar la calidad
de la imagen. Concluido este primer proceso de modificacion para los stacks,
colocamos la barra de escala. Aun asi, tuvimos algunas interferencias en las
imagenes provenientes por la luz o por el medio, por lo que se eliminaron esos
ruidos sustrayendo el fondo de las imagenes que forman a los stacks.

Figura 21. a) Imagen original capturada del frente de la colonia. b) Conversion de la imagen original
a escala de grises (8 bits) para reducir el tamafio de la imagen y disminuir el campo de vision. c)
Ajuste de contraste y brillo a la imagen para tener mejor visualizacion del micelio. d) Sustraccion de
fondo de la imagen, para solo tener el micelio eliminamos el fondo de la imagen para eliminar ruidos.
Barra de escala 1000 pum.
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Figura 22. a) Imagen original capturada del hongo en presencia de la raiz de la plantula. b)
Conversion de la imagen original a escala de grises (8 bits) para reducir el tamafio de la imagen. c¢)
Ajuste de contraste y brillo a la imagen para tener mejor visualizacion del micelio. d) Sustraccion de
fondo de la imagen, para solo tener el micelio eliminamos el fondo de la imagen para eliminar ruidos.
Barra de escala 1000 pum.

Para obtener la informacion de los stacks, nos centraremos en adquirir las
coordenadas de un apice elegido o cuando llegue el momento del frente de colonia.
Se eligi6 una hifa para seguirla en el trascurso del stack para obtener las
coordenadas del apice en cada imagen y determinar su crecimiento. La hifa llegé a
un punto donde no fue posible seguirla ya que, por la alta cantidad de ramificaciones
se generd una densidad de hifas alta, cuando lleg6 este momento obtendremos las
coordenadas de un punto central en el frente de la colonia.

Para empezar con este proceso, a medida que el stack avanzd y la hifa crecio, fue
necesario hacer movimientos en el campo de vision de manera manual, a causa de
gue el objetivo del microscopio solo alcanzé a detectar hasta cierta parte del hongo
conforme se va desarrollando, es por esta razén que observamos en el stack
cambios de area. Cabe sefalar que, a partir de estos traslados de campo en el
stack, segmentamos el stack en regiones (sub-stack) que nos permitio realizar el
procesamiento de una forma mas rapida, regularmente para cada stack completo
tenemos un total de 5 sub-stack para procesar.

Para cada sub-stack se seleccion6 un intervalo espacial de solo la hifa que se eligié
sequir, esto quiere decir que elegimos una ROI (Regién de interés). Comunmente
se selecciond la hifa que tenia mayor crecimiento, en vista que era la mas facil de
detectar en el trascurso del stack. Esta ROI se hizo para eliminar las otras hifas del
micelio que no nos servirian en este proceso y podrian dificultar la obtencion de
resultados. Al haber hecho este recorte de area, se procedié a realizar una
binarizacion al nuevo sub- stack. Se partié de hacer algunos ajustes al contraste y
brillo para resaltar los elementos del micelio que queremos estudiar. Lo siguiente es
hacer cambios en la umbralizacion que nos permitié realizar el paso de la
binarizacion que necesitamos, una vez binarizada, tendremos el stack en blanco y
negro. Finalmente se visualizaron algunas particulas que no pertenecen a la hifa o
la colonia, por lo tanto, se removieron de manera manual, para tener un stack limpio
y binarizado. Para concluir este proceso cuando es el caso del estudio a nivel hifa,
se hizo una esqueletizacion de la hifa, esto es, hacer un adelgazamiento de los
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pixeles que forman la hifa. En caso de estar en el proceso a nivel colonia solo
llegamos al paso de tener el stack limpio y binarizado.

Con todo el procesamiento de los stacks concluido, con ayuda de un plugin de
ImageJ/F1JI, llamado Tracking Mate, se selecciond el 4pice de la hifa conforme pasa
las imagenes. Al hacer uso de esta herramienta, las coordenadas (X,y) se guardaron
de manera automatica en un archivo Excel, por lo tanto, por muestra se tiene un
total de 140 coordenadas. Cuando se llegd el momento de obtener las coordenadas
por el método de frente de colonia, lo que se hizo fue elegir el centro del frente de
la colonia.

L -._ Gﬂ.
T T

Figura 23. a) Seleccién de intervalo espacial, al tener el frente de colonia elegimos la zona que
estara opuesto a la raiz. b) Umbralizacion de la imagen. c¢) Binarizacion de la imagen y eliminacion
de particulas, realizamos una limpieza de las imagenes. d) Obtencién de datos por frente de colonia,
en este paso homogenizamos todo el frente de la colonia. Barra de escala 1000 pm.

Al momento de analizar algunos stack de las imagenes, nos percatamos que en el
desarrollo del micelio hay un punto donde se hace una ramificacion considerable,
por ello, se hace el frente de colonia denso. Con esta nueva informacion podemos
darnos una idea de como es que se va transformando el micelio de hifas a colonia
(Figura 24).
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Figura 24. a) Hifas antes de la ramificacion (6:00). b) Inicio de la ramificacién. c) Formacion de un
frente con una densidad considerable. d) Termino del proceso de ramificacién densa a partir de
esto el crecimiento sigue de la misma manera. Barra de escala 1000 um. Las flechas blancas
indican el area de ramificaciones.

Por lo tanto, se desarroll6 una estructura para la adquisicion y procesamiento de
imagenes que nos fue posible aplicar en 10 muestras para obtener informacién
acerca del crecimiento del hongo con presencia y ausencia de la plantula. De igual
forma, fue posible observar la interaccion de ambos organismos de una manera
dindmica y comprender mejor el desarrollo tanto del hongo como de la plantula
conforme pasa el tiempo

3.5 El analisis de datos

Para realizar el analisis de datos, que tiene la finalidad de obtener informacion
cuantitativa acerca de la respuesta que tenga el hongo ante la presencia y ausencia
de la plantula, realizamos un proceso de construccion y analisis de datos, utilizando
el software Mathematica para automatizar este procedimiento. En el software
programamos una serie de instrucciones que nos permita insertar las coordenadas
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del archivo proveniente de FIJI, obtener la distancia de punto a punto con ayuda de
la distancia Euclidiana, obtener las graficas de la trayectoria de la hifa por secciones
y finalmente obtener el promedio de la velocidad en funcién del tiempo para cada
muestra con su grafica correspondiente.

En nuestro experimento obtenemos un conjunto de coordenadas {(xi, yi)}, en donde
i =1,...,n, las cuales definen la trayectoria del apice de una hifa. Para calcular la
velocidad instantanea de avance de la hifa (vi), consideramos la distancia entre
puntos consecutivos:

2
Ai =J[(xi+1 —x)2 + (Vi 1Y)l L.
y dividimos entre el intervalo de tiempo entre cuadros (At = 10 min):
Vi = = >
At

Finalmente, la distancia total de avance de la hifa es:
D=3 A >
y la velocidad promedio de la hifa:
Vpromedio = (1/N) Zi vi 4.
en donde N es el nUmero de cuadros en el stack.

De igual forma usamos la informacion de las coordenadas que obtuvimos de cada
muestra para realizar un grafico por secciones de la posicién de los apices conforme
pasa el tiempo cuando tenemos el caso a nivel hifa (Figura 25.a). Con esta misma
informacion de las coordenadas se pudo determinar la trayectoria por secciones que
recorri6 la hifa (Figura 25.b).

Con los datos de la velocidad por muestra se trasladé a manera de gréafica para
poder ver el comportamiento de las velocidades en el trascurso de las 24 h de cada
muestra. Al tener los datos de las velocidades tomadas cada 10 minutos podemos
ver en la grafica un total de 1440 minutos (24 h). Cabe sefalar mediante el protocolo
que realizamos en la construcciéon de nuestra minicamara sabemos que antes de
ser observado al microscopio el sistema hongo-plantula ya tenia 24 h juntos, por lo
tanto, consideramos la 0 h cuando colocamos la minicAmara ante el microscopio, al
término de las observaciones de 24 h en el sistema de observacion en total las
muestras estuvieron 48 h juntas.
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Figura 25. a) Obtencidn de la posicién de las coordenadas conforme crece el apice en el programa
de FIJI. b) Grafica de la posicion a partir de las coordenadas. c) Trayectoria de la hifa con las
coordenadas que se obtuvo en el procesamiento de imagenes en Mathematica. Se observa que
podemos realizar la trayectoria que tenga la hifa a partir de las coordenadas (x,y).

3.5.1 La distancia de crecimiento del micelio

Comenzamos con los datos que se obtuvieron de las pruebas control, se hicieron
un total de 5 muestras control para hacer la comparacién con las pruebas hongo-
plantula. De manera cuantitativa podemos ver en la tabla 1 la distancia recorrida en
las muestras de 24 h del hongo control.
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Hongo Distancia

control total (um)
1 6045.78
2 5827.76
3 6134.13
4 4874.97
5 4254.91

Tabla 1. Distancias totales recorridas de las cinco muestras control.

En la tabla 2, observamos los datos obtenidos de la distancia total de las pruebas
del hongo creciendo con la plantula al paso de 24 h.

Hongo- Distancia

planta total (um)
1 3200.15
2 3251.52
3 3832.22
4 3447.68
5 3080.93

Tabla 2. Distancias totales recorridas de las cinco muestras del hongo cuando esta ante la
presencia de la plantula.

Como podemos observar en ambas tablas, tenemos la informacion suficiente para
hacer una comparacion de datos de las pruebas control con las pruebas hongo-
plantula. Se muestra que, cuando el micelio estuvo creciendo solo, sin ninguna
interaccidn de algun tipo, la hifa presentdé una mayor distancia recorrida en el tiempo
de 24 h, por lo tanto, tuvo un crecimiento mas rapido a comparacion de la prueba
hongo-plantula. Por otro lado, cuando el micelio estuvo en presencia de la plantula,
la hifa recorrié una distancia mas corta, lo que indica un crecimiento mas lento.

3.5.2 Lavelocidad de crecimiento apical y frente de
colonia

En cuanto a la velocidad, obtuvimos de igual forma informacién para cinco muestras
en cada caso. Haciendo uso de los datos que obtuvimos de la distancia total
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recorrida por cada muestra y el tiempo de 10 min, que es el tiempo que trascurre
entre cada punto. Se hizo uso de la férmula 2, para obtener la velocidad promedio
que tiene cada una de las muestras. Los datos obtenidos se pueden observar de
manera cuantitativa en las tablas 3y 4.

Muestra Promedio

hongo de la
control velocidad
(um/min)

1 4.40

2 4.19

3 4.38

4 3.88

5 3.01

Tabla 3. Velocidad promedio del hongo en las cinco muestras control.

Para el caso del hongo junto con la planta, se siguié el mismo procedimiento ahora
tomando en cuenta la informacion que tuvimos con respecto a las pruebas del hongo
interactuando con la plantula.

Muestra Promedio

Hongo- de la
planta velocidad
(um/min)

1 2.25

2 2.37

3 2.75

4 2.48

5 2.16

Tabla 4. Velocidad promedio del hongo de las cinco muestras de la interaccién hongo-plantula.

De igual forma, al trasladar los datos de la velocidad a graficas, conforme paso el
tiempo se puede observar el comportamiento del micelio bajo las dos condiciones.
Las flechas en las gréficas indican la transicion del analisis de nivel hifa a nivel
colonia, como lo indican las flechas el momento del cambio es variado, por lo tanto,
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no concluimos un patron que fuera presente en esta transicion del estudio (Figura
26).
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Figura 26. a) Grafica correspondiente a la velocidad promedio de las muestras del control. Las
flechas corresponden a el tiempo en donde el analisis pasa de forma de hifa a frente de colonia.
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Figura 27. a) Gréfica correspondiente a la velocidad promedio de las muestras de la interaccion
hongo plantula. La flecha indica el cambio del andlisis nivel hifa a frente de colonia.

En cuanto a la informacién de ambas tablas, observamos que existe diferencias en
cuanto a la velocidad promedio del control con la velocidad promedio de la prueba
hongo-plantula (Figura 29). Obtuvimos una velocidad promedio total de 4.10 (Figura
26) um/min de las pruebas control y una velocidad promedio total de 2.40 pm/min
de las pruebas hongo-plantula (Figura 27). Con esta informacién podemos sugerir
gue el hongo detecta la presencia de la plantula aun sin contacto fisico, ya que
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disminuye aproximadamente a la mitad su velocidad promedio (Figura 29). Pero si
observamos mas detenidamente las graficas de las 10 muestras (Figura 26) (Figura
27), podemos obtener mas informacion acerca del desarrollo de la velocidad en
cada uno de los casos, siendo muy distinto el comportamiento que presenta el
hongo en las pruebas control, a el comportamiento que tiene en las pruebas hongo-
plantula (Figura 28).

Comparacion de las velocidades totales entre las muestras control y pruba experimetal
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Figura 28. a) Grafica comparativa de todas las muestras. Las gréaficas de color azul corresponden a
las muestras control y las gréficas en color rosa corresponde a las muestras hongo-planta. Podemos
observar que las muestras con planta tienen velocidades menores en comparacién a las muestras

control.

Para detectar de mejor manera los distintos comportamientos del hongo en los dos
casos, recolectamos todas las velocidades tanto control como de las pruebas
hongo-plantula en una solo grafica (Figura 29). Como podemos observar en la
gréfica, en el caso de las muestras control (lineas azules) tiene una velocidad mas
aleatoria desde un inicio, pero no disminuye la velocidad hasta llegar a cero, esto
indica que, aunque las velocidades sean aleatorias siempre tendran un valor. En
cambio, para la velocidad de las muestras hongo-plantula (lineas rosas), la
velocidad promedio es mas pequefia que el control. En la gréafica de la Figura 28,
existe una etapa primaria en la cual, el hongo tiene una velocidad mas lenta hasta
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llegar a un punto donde cada vez va aumentando. Lo segundo a notar, es que en la
grafica tenemos la presencia de puntos donde la velocidad no aumenta solo se
permanece en cero, por lo cual no hay una contribucion a la velocidad. En este tipo
de situaciones podemos sugerir que el hongo tiene una reaccién ante la presencia
de la plantula por lo que detiene su crecimiento.
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Figura 29. Grafica de comparacién de los promedios de las velocidades totales de las diez muestras
a estudiar con su desviacion estandar. La linea gris corresponde a las cinco pruebas control y la
linea roja corresponde a las cinco pruebas hongo-plantula.

3.5.3 Analisis del crecimiento de colonia a nivel
macroscopico

Para realizar un estudio mas completo de los cambios que puede tener el hongo en
ausencia y presencia de la plantula, realizamos un analisis de la colonia fangica,
debido a que, nos interesa conocer todo el panorama de alteraciones que pueda
ocurrir en la estructura del micelio.
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Para este estudio se analizaron las 3 muestras de las pruebas control y tres
muestras para las pruebas de interaccion hongo-plantula. Lo realizamos de tal
manera en que sincronizamos todas las muestras para tratar de disminuir las
variaciones lo mas posible. Lo que hicimos fue medir el diAmetro del micelio de las
muestras en ambos casos, cuando trascurrieran 24 h, 48 h'y 72 h para lograr tener
mas informacion de los cambios morfologicos a nivel colonia al tener mas tiempo de
estudio. Para obtener los datos de manera general y asi poder graficar en ambas
situaciones obtenemos el promedio de diametro de las tres pruebas en cada caso
con su respectiva desviacion estandar, para trasladarlos a manera de grafica.

Micelio Promedio del Desviacion
Control diametro estandar
(cm)
24 h 0.9 0.17
48 h 33 0.10
72 h 5.43 0.37

Tabla 5. Promedio del diametro del micelio control al trascurrir 24 h, 48 hy 72 h.

Micelio Promedio Desviacion
Planta- del diametro estandar
Hongo (cm)

24 h 0.46 0.15

48 h 3.03 0.45

72 h 4.43 0.40

Tabla 6. Promedio del diametro del micelio ante la presencia de la plantula al trascurrir 24 h, 48 hy 72 h.
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Figura 30. Grafica correspondiente a los didmetros promedios de 24 h, 48 h'y 72 h con el hongo
control y el hongo con la plantula. Podemos observar que las muestras control tienen un diametro
mayor conforma pasa el tiempo comparandolo con las muestras hongo-plantula véase Tabla 5y 6.

Como podemos observar en la grafica de la Figura 30, se observa que el micelio
control presentd un crecimiento mayor en comparacion al micelio ante la presencia
de la plantula. Algo que notamos fue que, al momento de tomar las mediciones del
diametro del micelio al estar con la plantula, el micelio crecia de manera desigual.
Por lo tanto, se tomaron medidas de los radios del hongo donde notamos que el
crecimiento de la colonia era distinto (Figura 32.c). Nos percatamos que las
diferencias del crecimiento eran mas notorias en el frente de la colonia en las horas
de 48 hy 72 h porgue a 24 h el micelio aun crecia homogéneamente.

De modo que, solo registramos las medidas de los radios del micelio en las horas
48 h'y 72 h y denotamos que el lado A es el radio que esta del lado de la plantula.
El lado B es el radio que esta de manera contraria a la plantula (Figura 32.c).
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Hora 48 Lado A Lado B
2.5cm 0.5cm
2.6 cm 0.9cm
1.8cm 0.8 cm

Hora 72 Lado A Lado B
2.1cm 1.9cm
3.3cm 1.2cm
2.6 cm 2.2cm

Tabla 7 y 8. Medidas del radio al paso de 48 h, lado A es el que da a la plantula y lado B es el que esté al contrario de la
plantula. Medida del radio al paso de 72 h, lado Ay lado B.

Hora 48

Lado C

1.7 cm

1.6 cm

1.65cm

Hora 72

Lado C

2.8cm

2.85cm

2.5cm

Tabla 9y 10. Medidas del radio al paso de 48 h, lado C corresponde al radio de la colonia del hongo control. Medida del
radio al paso de 72 h, lado C.

Pudimos percatarnos de una tendencia del hongo de crecer méas rapido cuando esta
en un contacto mas directo con la plantula, teniendo una diferencia significativa en
comparacién a cuando el micelio esta al lado opuesto del frente de la colonia con
respecto a la raiz. Con esto podemos sugerir que el hongo detecta a la raiz y tiene
un desarrollo mayor a cuando el micelio esta mas alejado de la plantula. En la
captura de imagenes macroscopicas podemos observar el desarrollo del micelio al
largo de 24 h, 48 hy 72 h. Detectamos en las pruebas de interaccion hongo-plantula
gue el frente de colonia sufre algunos cambios en su morfologia ya que no crece de
una manera homogénea por ambos lados, en comparacion con las muestras control
gue siempre fue persistente un crecimiento homogéneo.
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Figura 31. a) Inoculaciéon de hongo. b) Micelio después de 24 h. c) Micelio después de 48 h, tiene
un crecimiento radial y homogéneo. d) Micelio al cabo de 72 h. Barra de escala 2 cm.
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Figura 32. a) Inoculacion del hongo creciendo con plantula. b) Micelio después de 24 h. c)
Crecimiento del hongo con la plantula después de 48 h, se observa un crecimiento irregular, linea
azul corresponde al radio r; (lado A) y linea verde corresponde al r, (Lado B). d) Micelio del hongo
después de 72 h. Barra de escala 2 cm.
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4. CONCLUSIONES

A lo largo de este estudio pudimos concluir varios aspectos, que fueron posibles
para el desarrollo y andlisis de informacion en este proyecto.

v

Preparaciéon de organismos: Trichoderma atroviride y Arabidopsis
thaliana.

Siguiendo los protocolos de preparacién del hongo y la plantula, se pudo
cultivar a ambos organismos libres de contaminacion en tiempos correctos
para su observacion y analisis.

Construccion de la minicamara de crecimiento y la caja negra.

Se establecid una estrategia para crecer ambos organismos en un solo
sistema, el cual denominamos minicamara de crecimiento.

De igual forma, fue posible desarrollar un sistema de microscopia, en el cual,
nos permiti®6 observar la interaccion del hongo y la plantula
microscopicamente, cumpliendo con las condiciones que establecimos para
Su crecimiento y observacion.

Adquisicion y procesamiento de iméagenes.

Al capturar la interaccion de ambos organismos de forma dinamica (stack),
fue posible detectar la manera en que se da este acercamiento entre
Trichoderma atriviride y Arabidopsis thaliana y poder extraer informacion de
los stacks por procesamiento de imagenes y desarrollar un analisis
estadistico.

Analisis de datos.

De forma cuantitativa y cualitativa vemos el crecimiento del micelio en dos
situaciones diferentes, cuando esta solo y cuando esta ante la presencia de
la plantula, concluyendo que efectivamente existe una respuesta por parte
del hongo, ya que se presentan diferencias en el comportamiento del micelio
en ambos casos.

La velocidad de crecimiento apical y frente de colonia.

En cuanto a el promedio de la velocidad control total del hongo se tiene un
promedio de 4.10 um/min el cual, efectivamente concuerda con estudios
anteriores que han determinado que el promedio de la velocidad del hongo
es de 4.32 pm/min (Sanchez-Orellana et al., 2019). En caso de el promedio
de la velocidad total del hongo en presencia de la raiz se tiene que es 2.40
pm/min siendo menor que el control.

Con estos datos podemos concluir que la respuesta del hongo en interaccion
con la plantula, crece mas lento, comparo con las condiciones control en
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ausencia de la planta. De igual forma, observamos en las graficas que la
velocidad en la interaccion tiende a ser muy lenta en el principio del estudio,
dandonos un indicio que el hongo tarda mas en reaccionar para crecer en
comparacion a cuando se encuentra solo.

v' El analisis del crecimiento de colonia a nivel macroscopico.

Por otro lado, al hacer un analisis de manera macroscopica vemos que, en
una situacion de colonia, el micelio control crece de una manera mas rapida
y homogénea a cuando esta con la plantula cuando esta con la raiz, el
crecimiento de todo el micelio es lento ademas que tiene irregularidades en
su frente. Los cambios que presentd el micelio, fueron debido a que es
notoria la diferencia de los radios de la colonia, porque cuando esta mas
cerca de la plantula tiene una radio mayor a cuando esta mas lejos de la
plantula.

Con estos datos, vemos que el hongo presenta cambios en su morfologia en
presencia de la plantula, debido a que, el hongo presenta cambios en su
comportamiento, alterando su forma de crecimiento y caracteristicas de su
desarrollo. De igual forma, vemos que el hongo responde ante la presencia de la
plantula, ya que, en este caso el hongo detecta la presencia de la plantula sin
contacto fisico, respondiendo de una forma diferente a como si creciera solo,
proporcionando informacién de como el hongo percibe condiciones distintas en su
entorno.
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5. PERSPECTIVAS

Como trabajos futuros a realizar, se puede realizar este estudio de una manera
automatizada.

Se podria aplicar la observacion del hongo con la planta no solo 24 h si no tiempos
mas largos. Ademas de probar con distintas edades de plantas para confirmar los
cambios que presentaria el hongo con estas nuevas condiciones.

Un andlisis que nos ayudaria a complementar como se dan estos cambios en la
morfologia de los hongos es aplicar este estudio, pero con otros tipos de hongos
filamentosos y plantas modelo. Este analisis nos daria una idea mas amplia de como
en la naturaleza existe esta comunicacion entre organismos.

Otra situacion para estudiar seria analizar de manera microscopica mas a detalle la
trasformacion del hongo de nivel hifa a cuando pasa a una colonia densa, ya que
observamos que existe un momento donde el micelio alcanza una gran densidad de
hifas formando una colonia densa.
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7. ANEXOS

Apéndice 1

Para tener la cantidad de 1x10°conidios/ml, se hara la recolecciéon de conidios
usado agua destilada estéril por lo cual, se preparara una dilucion 1:100 haciendo
uso de 10 ul de los conidios recolectados y 990 pl de agua destilada estéril. Como
paso siguiente se colocara la cantidad de 10 ul de esta solucién diluida en una
camara de Neubauer para realizar el conteo por duplicado en un microscopio 6ptico
siguiendo los pasas que describe en “Manual Cell Counting With Neubauer
Chamber”

Una vez hecho este conteo, se procedié hacer un promedio de los conidios contados
en las pruebas y se aplico este dato en las siguientes formulas.

Conidias contadas en 80 cuadros de 0.0025 mm?
Conidias por pl =

Superficie contada (0.2 mm?) x (profundidad de la cdmara (0.1mm) x (dilucion)

C1V1=C2V2 4.

La formula 3, nos indica la cantidad de conidios que tenemos por ply con la segunda
férmula establecimos la concentracion de conidios que es necesaria depositar en
un ml de nuestra suspensidn que sera en base a un buffer de Trichoderma
(Sacarosa y MS).

Como se menciond, este procedimiento fue hecho cada mes para tener conidios
frescos, por lo tanto, la cantidad de concentracion de conidios que se obtuvo vario
en cada una de las pruebas realizadas. Al tener la dilucion de conidios frescos
contenida en un tubo Eppendorf, se llevd a un cuarto a 4° y solo fue sacado cada
vez que fuera necesario realizar las muestras.

Referencias

Laboratory info. (s.f.). Obtenido de https://laboratoryinfo.com/manual-cell-counting-

neubauer-chamber/
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Apéndice 2

Macro realizado en ImageJ/FIJI para la primera parte de segmentacién de los
stacks.

run("Images to Stack", "use");

run("8-bit");

run("Specify...", "width=1646 height=1534 x=464 y=0 slice=1");
run("Duplicate...", "duplicate");

selectWindow("Stack");

close();

selectWindow("Stack-1");

run("Bin...", "x=2 y=2 z=1 bin=Average");

run("Concatenate...", "open imagel=Stack-1 image2=Stack-2");
run("Set Scale...", "distance=271 known=1000 unit=um");
run("Duplicate...", "duplicate");

run("Gaussian Blur...", "sigma=2 scaled stack");
imageCalculator("Subtract create 32-bit stack", "Untitled","Untitled-1");
selectWindow("Result of Untitled");

selectWindow("Untitled-1");

close();

run("Scale Bar...", "width=1000 height=393 thickness=4 font=14 color=White background=None
location=[Lower Right] horizontal bold overlay");

selectWindow("Untitled");
close();

selectWindow("Result of Untitled");
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Apéndice 3

Programa realizado en Mathematica para obtener el andlisis estadistico:
Distancia, Trayectoriay Velocidad.

DATOS11 = Import["D:\\IMAGENES TESIS\\DATOS\\PRUEBAS\\PREUBA2\
\CONTROL\\4 — 5\\REGION 1 — 18\\REGION1 — 18. xIsx"];

Ucoordenadas11
= {{55.,14.},{55.,14.},{55.,14. },{55.,17. },{53.,15. },{51.,16.},{49.,17.}, {46.,18. },{45.,19. },

{42.,21.},{40.,23.},{36.,25.},{31.,27.},{22.,33.},{19.,34.}, {14.,36.},{11.,38.}, {7.,39. }}

[O0Length[coordenadas11]

BListPlot[coordenadas11, Frame — True, FrameLabel — {"X","Y"}ImageSize
- Large, LabelStyle — {GrayLevel[0]}, PlotLabel - "POSICION"]

EListPlot[coordenadas11, Frame — True, FrameLabel — {"X","Y"}, Joined — True, ImageSize
— Large, LabelStyle — {GrayLevel[0]}, PlotLabel - "TRAYECTORIA"]

TABLAP11 = Table[EuclideanDistance[coordenadas11[[i]], coordenadas11][i
+ 1]]],{i, 1, Length[coordenadas11] — 1}]

ListPlot[TABLAP11, Frame — True, FrameLabel = {"X","Y"}, Joined — True, ImageSize
— Large, LabelStyle — {GrayLevel[0]}, PlotLabel — "DISTANCIA"]

DISTANCIA11UM = 3.69{TABLAP11}
EVELOCIDAD11UM = {3.69{TABLAP11}}/10

Tiempo1l1l = {1,10,20,30,40,50,60,70,80,90,100,110,120,130,140,150,160};
DATOSENLACEDISTANCIA11 = Thread[{distanciall, Tiempo11}]
datall = Transpose[{Tiempo11, distanciall}];

gl = ListPlot[data11, PlotStyle — PointSize[Medium], Frame — True, FrameLabel
— {"Tiempo (min)", "Distancia (um)"},Joined — True, PlotLabel
— "Distancia Sobre tiempo", PlotLabel — "distancia sobre tiempo", ImageSize

— Large, LabelStyle — {GrayLevel[0]}, PlotStyle = Hue[0.1]]

dataVll=Transpose[{Tiempoll, velocidadll}];
gVll=ListPlot[dataVll,PlotStyle->PointSize[Medium], Frame-
>True, FrameLabel->{"Tiempo (min)","Velocidad (um/min)"},Joined-
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>True, PlotLabel->"Velocidad Sobre tiempo",ImageSize-
>Large,LabelStyle->{GrayLevel [0]}]

TOTAL

BEDISTANCIATOTAL11
= {DISTANCIA11UM, DISTANCIA21UM, DISTANCIA31UM, DISTANCIA41UM, DISTANCIA51UM,

DISTANCIA61UM, DISTANCIA71UM}

Length[distanciapt11]

distanciaT11 = Total[distanciapt11]

DESVIACION = StandardDeviation[distanciapt11]

TIEMPOTOTAL11
= {Tiempo11, Tiempo21, Tiempo31, Tiempo41, Tiempo51, Tiempo61, Tiempo71}

BdataT11 = Transpose[{tiempototalll, distanciapt11}];@gT11 = ListPlot[dataT11, PlotStyle
— PointSize[Medium], Frame — True, FrameLabel
- {"Tiempo (min)", "Distancia (um)"}, Joined — True, PlotLabel
— "Distancia Sobre tiempo", PlotLabel — "distancia sobre tiempo", ImageSize
— Large, LabelStyle — {GrayLevel[0]}, PlotStyle - Hue[0.1], PlotRange — All]

BVELOCIDADTOTAL11
= {VELOCIDAD11UM, VELOCIDAD21UM, VELOCIDAD31UM, VELOCIDAD41UM, VELOCIDAD51UM, VELOCIDADG6

velocidadt11 = Total[velocidadpt11]

dataVTll=Transpose|[{tiempototalll, velocidadptll}];
gVTll=ListPlot[dataVT1ll,PlotStyle->PointSize[Medium], Frame-
>True, FrameLabel->{"Tiempo (min)","Velocidad (um/min)"},Joined-
>True, PlotLabel->"Velocidad Sobre tiempo",PlotLabel->"distancia
sobre tiempo",ImageSize->Large,LabelStyle-
>{GrayLevel[0]},PlotRange->Al11]

PROMEDIO1 = Mean|velocidadpt11]
DESVIACION1 = StandardDeviation[velocidadpt11]
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